Axicon in-line barcode verifier

user guide
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Important information</td>
<td>4</td>
</tr>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Installation</td>
<td>6</td>
</tr>
<tr>
<td>Calibration</td>
<td>8</td>
</tr>
<tr>
<td>Setup</td>
<td>10</td>
</tr>
<tr>
<td>Using the software</td>
<td>12</td>
</tr>
<tr>
<td>Settings</td>
<td>14</td>
</tr>
<tr>
<td>Cradle setup</td>
<td>18</td>
</tr>
<tr>
<td>Stand alone mode</td>
<td>21</td>
</tr>
<tr>
<td>Software licence</td>
<td>22</td>
</tr>
<tr>
<td>Warranty</td>
<td>24</td>
</tr>
<tr>
<td>Service contract</td>
<td>25</td>
</tr>
<tr>
<td>Factory re-calibration</td>
<td>26</td>
</tr>
<tr>
<td>Certificate of conformance</td>
<td>27</td>
</tr>
<tr>
<td>Contact us</td>
<td>28</td>
</tr>
</tbody>
</table>
Important information

The Axicon verifier is a high precision opto-electronic device and should be handled carefully. Please keep and use the case to protect the verifier when it is not in use.

Only use power and data cables supplied by Axicon as the use of non-approved accessories will invalidate the warranty. If the verifier is dropped (or subjected to similar misuse) the accuracy of the results may be affected and it should be returned to Axicon immediately for servicing.

We recommend that the verifier is factory recalibrated annually to ensure that it remains compliant to ISO/IEC 15426-1. The unit should be returned to Axicon or to your approved Axicon reseller for this servicing.

Software updates are always available free of charge, and can be downloaded from our website, www.axicon.com
Introduction

What is in the case

One of the following verifiers:

- Axicon 6525-S barcode verifier with USB cable.
- Axicon 7025-S barcode verifier with USB cable.
- Software CD.
- Wallet containing this user guide and calibration sheet.

The Axicon verifier is designed to work with any PC running a version of Microsoft Windows currently supported by Microsoft.
Installation

**Software installation.**
Insert the CD into the CD drive. The Install Program should run automatically. (If not, open the CD using Windows Explorer and double-click the Autorun Program). Click **Install Axicon Verifier** and follow the installation instructions.

At the **Select components to install** window ensure that the boxes relating to **Drivers**, **Main Program** and **Inline** are all ticked. After installation is completed you will find the **Axicon Verifier** directory in **Start Menu/Programs** and a shortcut to the program on your desktop.

If you have downloaded the software from our website then simply click on the setup file and follow the instructions.

**Hardware installation**
Plug the verifier into any available USB port on the computer. For Windows 7 and Windows 8 installations the drivers should be installed automatically.

**Note:** Please follow these installation instructions in the correct order, namely installing the software before the verifier is plugged into any USB port. If the verifier is plugged in before the software has been installed, Windows will attempt to find the correct drivers for the verifier via the internet, and choose an incorrect option. This then causes problems as the software is then unable to install the correct driver.
When you reach the **Select components to install** window you will see the boxes alongside **Drivers** and **Main Program** have been preselected. At this point you will also need to select the **Inline verifier** box. If you want to use the **Scan File Data Extractor**, select this option by ticking the box.

The Scan File Data Extractor enables you to summarise and record all the verifications made in a standalone database. It uses the data from the Axicon scan files (those with a .scn extension) to create a complete record of all the files that have been saved, either automatically or manually. More information about this is available via the website www.axicon.com.
Calibration

Calibration should be carried out after installation and at regular intervals. When the software detects an uncalibrated reader the following dialogue box will appear Reader XXXX (serial number) has not been calibrated. You must click OK to continue. You will also need your calibration sheet which should be located in your documentation wallet.

Use either of the large calibration codes at the bottom of the sheet.

Calibration is a quick and simple process. First open the Axicon verifier software (main program), select Calibrate from the Options menu of the command window (or press F2). You will see a window with two edit boxes for minimum and maximum reflectance values. Ensure that the values shown in the window match the values printed at the bottom of the calibration sheet. Modify the figures on the window if necessary to ensure that they are the same as the card.

With the Calibration window open scan the calibration barcode 10 times. Then click the OK button. The verifier is now calibrated and ready to use. After calibration, store the calibration sheet in the documentation wallet, away from light and physical damage. If your calibration sheet should ever become damaged or discoloured, please contact Axicon or your supplier for a replacement.
When using the in-line verifier software it is essential that the calibration log file is located in the same directory as the in-line verifier program. If it is located elsewhere then the in-line verifier software will not find it and will request the user to calibrate the verifier.

![Calibrate: A372 window](image)
Setup

The Axicon in-line barcode verifier has been designed to provide verification of barcodes presented in picket-fence format as these symbols are being printed using thermal transfer printers. It is designed to only read and verify one barcode across the label.

The speed with which verifications can be made is dependent on the speed of the computer to which the verifier is connected. Its performance may also be reduced if the computer is running other applications or is connected to other USB devices. Axicon recommends a computer with a processor speed of at least 1.2GHz and it should be running with at least 512 MB of RAM.

Cradle setup

The use of the Axicon cradle is recommended because it has an adjustable height (See page 24 on how to setup the cradle).

The user should ensure that the verifier is just slightly lower than where the labels leave the printer, so that as the labels emerge they drop slightly before passing under the Teflon strip at the front of the verifier.

The verifier stand should be positioned under the printer, using the weight of the printer to hold it in place. It should be positioned so that the front of the verifier is as close as possible to the print head whilst allowing appropriate access to the printer.
The verifier should be positioned flat within the cradle and held firmly by the metal spring mechanism.

**Pause Interface**
The in-line verifier application can be used to stop some printers if an error is observed or if barcode print quality drops below an acceptable standard.

The following printers are examples of those which can be paused in this way:
- TEC
- Sato
- Datamax “H Class” (Optional GPIO port needs to be fitted)
- Zebra 105 and XIII, XiIII, and Xi4 series - These requires an applicator port option to be fitted to the printer.

**Rewinder**
For the verifier to work correctly the barcodes should pass under the verifier under tension and at a relatively constant speed.

If an internal rewinder is being used, then the labels should pass from the printer, over both of the rollers in the verifier cradle, round the rear roller and back to the printer. The rewinder will maintain the correct speed.

If an external rewinder is being used, it should be clutch-driven as this can maintain tension with a constant speed.
Using the software

To start a print verification run, you first need to select Run and Go (F2). The Job name window will appear, enter a job name or leave blank (a job name will need to be entered to save the scan file). The verifier will now start verifying barcodes and display the results on the screen.

All pass reads are displayed in green and all fail reads are displayed in red.

A new line is started on this screen every time the application sees a decodable barcode. The verifier will automatically check the print quality of each barcode and report the overall ISO/IEC grade.

Once the print run has finished, simply select Stop (Run, Stop). A window will appear where you can add any notes about the verification run.

The command icons:

- To start the verification, or use F2
- To pause the verification
- To stop the verification, or use F4
- To view the summary of a verification print run, or use F6
- To detect a reader, or use F3
- To view the setup windows, or use F5
- To view the advanced setup windows, or use F7
- To toggle scan display tracking
If the verifier has a failed read, the row will be highlighted in red and display a message in the info column.

If there is any part of the barcode that cannot be decoded (for example because of ribbon wrinkle) the scans in this area cannot be taken into account.

The software’s method of identifying such damaged codes is to provide the user with the number of decoded scans for each barcode, and to provide a facility whereby if the number of decoded scans falls below a pre-set limit then the barcode can be regarded as unacceptable.

Saving
By default the software application will only save sets of scans that fail to meet the pass criteria and then only if the verification run has been given a job name. When starting a job there is the option to give the subsequent saved information a job name or it can just be saved as a default job.
Settings

The verifier has a range of configuration settings. These can be set by clicking on Options and then Settings.

The General tab shows options associated with pass grade and by default the application will apply the requirements of the GS1 General Specifications. For other barcodes such as Code 39, it is possible to select a minimum pass grade on this screen.

The Check Characters tab shows the optional check characters for symbologies which do not have a mandatory check digit, so these can be checked or not depending on the settings selected.
The **Logging** tab shows the job folder where results are saved. This can be configured to save all scans, failed scans, or none. These results will be saved as Axicon’s .scn files.

When a job is run two other files will always be created. These are a summary file stored as an HTML page (shown earlier in this document) and a CSV file which contains detailed information for each symbol that has been scanned.

If no job name is entered when the job starts, then only the summary HTML and the CSV files will be created and these files will be called Default.HTML and Default.CSV respectively. These files will be overwritten if a job name has not been created.
Settings

This **Sequential** tab shows the sequential numbering and duplicate checking options. To use sequential numbering the enable box should be ticked and the settings for the number increment or decrement should be made with any masking that may be required.

The duplicate checking facility enables the application to check whether the numbers being printed have already been used.

The Axicon in-line system can check for the existence of duplicated numbers, not only within the current print run but also across print runs which may have been made months or even years earlier. The system can hold any number of separate databases holding records of different jobs - each of which should have unique references.
The Plugins tab allows the software to be tailored to industry specific or user specific features, such as running a product lookup database, validation of the structure of variable weight items, or checking the formats of European pharmaceutical codes. The plugins can be installed from the CD by using the **Install Optional Plugins** or can be downloaded from our website. An explanation of what each plugin does is on our website.

The Action tab can define the action to be performed if an error occurs. In order to make use of this feature, it is necessary to have the appropriate interface with the printer.
Cradle setup

The kit comprises the following items - please check that you have all of these available before you start the assembly.

- Base plate (1)
- Vertical supports (2)
- Screws (4)
- Assembled cradle unit (1)
- Knurled screws (2)
There are four pairs of holes in the base plate. The two inner pairs of holes are used with the Axicon 6525-S verifier. The two outer pairs of holes are used with the 7025-S.

The two vertical supports will be fitted to the base plate using the four small screws. The screws will need to be fitted from the underside of the baseplate.

The vertical support should be positioned on top of the base plate. It is important that the slot in the vertical support is nearer the short end of the base plate.

The cradle assembly position should be in between the vertical supports. Make sure that the roller is facing the longer end of the base plate.

Secure the cradle to the vertical supports using the two knurled screws.
Cradle setup

The verifier is then positioned into the baseplate by inserting it front first and positioning it against the two stops on the cradle.

The rear of the verifier is then lowered and it is held in place by the sprung-metal clip at the rear.

The longer end of the baseplate should then be positioned under the thermal transfer printer.

The height of the cradle is fully adjustable. To alter the height simply release the knurled screws, raise or lower the height of the cradle assembly and then re-tighten the screws.

When in use the labels should pass from the printer, over both of the rollers in the cradle assembly and then back to a rewinder.

The easiest way to feed labels through the verifier assembly is to lift the verifier out of the cradle, pass the labels over the rollers and then put the verifier back into place.
Stand alone mode

The Axicon verifiers are all also designed to be used in stand alone mode with the verifier positioned so that it touches the barcode, as shown in the pictures below.

When you first start the main software you will see the Command window and the Summary window.

The Command window gives access to all of the main features of the verifier. Use the pull down menus or the icons to operate the software.

The Summary window shows the overall print quality of the barcode as measured by the ISO/IEC or ANSI standards.

There are five more windows you can open to look at the verification results. Go the View menu on the Command window, and the select the window you want, or use the icons that appear just below the menu headings. If you hold your mouse over each icon a brief description of its function will appear at the bottom left of the Command window.

The verifier should be placed either just above or just below the barcode and the trigger pressed. With the trigger still pressed, move the verifier down the height of the barcode. The verifier will scan at the rate of 100 verifications a second until it reaches the bottom of the barcode (or gets to the maximum number of scans).

The verifier will automatically calculate an average of the results of all of the scans to provide an overall quality grade based upon an assessment across the scanned bar height.
Software licence agreement

Use of the software is subject to the Axicon software licence terms set out below. Using the software indicates your acceptance of these licence terms. If you do not accept these within 14 days, you may return the entire unused product for a full refund.

Axicon grants you a licence to use any number of copies of the software, but only for use with an Axicon verifier. “Use” means storing, loading, installing, executing or displaying the software. You may not modify the software or disable any of its licensing or control features.

Ownership
The software is owned and copyrighted by Axicon Auto ID Limited. Your licence confers no title or ownership in the software and is not a sale of rights in the software.

Copies
You may only make copies of the software for archival purposes or when copying is an essential step in its use. You must reproduce all copyright notices in the original software on all copies. You may not copy the software onto a bulletin board or similar publicly accessible system.

No disassembly or decryption
You may not disassemble or decompile the software without prior written consent from Axicon.

Transfer
Your licence will automatically terminate upon any transfer of the software. Upon transfer, you must deliver the software, including any copies and related documentation, to the transferee. The transferee must accept these licence terms as a condition of the transfer.

Termination
Axicon may terminate your licence upon notice of failure to comply with any of these terms. Upon termination, you must immediately destroy the software, together with all copies, adaptations and merged portions in any form.
Export requirements
You may not export or re-export the software in contravention of any applicable laws or regulations.

This agreement should be construed in accordance with the laws of England.

DISCLAIMER
In the following the expression “verifier” means the verifier hardware and the associated software.

We have taken care to ensure that this verifier is free from defects. However since we have no control over the circumstances in which you might use it you must satisfy yourself that it is suitable for your needs. Neither Axicon Auto ID Limited nor the vendor of this verifier can accept any liability for any loss or damage (consequential or otherwise) which may be caused by its use.

If the verifier or any part of it is defective in any way, or in some other way does not meet your expectations, the liability of Axicon Auto ID Limited is limited to the cost of the product. You should bear this limitation in mind if you use this verifier in any situations where the acceptance or rejection of shipments of goods or your reputation may depend upon the quality of a barcode.
Warranty

All Axicon products covered by this documentation (Axicon 6525-S and 7025-S verifiers) are sold with a two year parts and labour warranty against manufacturing defects. This is a return to bench warranty with shipping costs in one direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate packaging) must be used. If the equipment is returned without the original case, we will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard warranty does not include the provision of a loan unit. Loan units can be supplied on request.

Axicon reserves the right to charge an inspection fee for any equipment returned under warranty for which no fault is found. Please contact us to obtain an RMA number before returning any equipment. This number must be quoted on all documentation. We cannot accept responsibility for equipment returned without an RMA number.
Service contract

A service contract may be purchased within 30 days from the date of despatch. This allows you to return your verifier back to us at no extra cost for its annual VCAS (verifier calibration and alignment service) so that you can be sure it still measures barcode quality in accordance with the requirements of ISO/IEC 15426-1.

The service contract will also extend the warranty beyond two years, so that if the verifier breaks down, all parts and labour will be provided free of any extra charges. The only exception is when the verifier has been misused, in which case labour costs will be covered, but not those of the parts. It is also possible to hire a verifier from us while your verifier is being serviced or repaired.
Factory re-calibration

All verifiers need servicing every year to ensure that they measure barcode quality in accordance with the relevant ISO/IEC standards. This verifier calibration and alignment service (VCAS) ensures that the verifier is internally dust-free, checks that it is focused correctly, and re-calibrates the hardware to account for any change in the brightness of the LEDs used to illuminate the barcodes.

This factory re-calibration is not the same as user calibration, as it looks at the output of the LEDs and corrects for any variance in their evenness of illumination across the whole field of view. Over time the LEDs will fade but they will not fade uniformly. User calibration ensures that the verifier is measuring the darkest and brightest reflectances correctly but it cannot correct for any variance in the illumination.

After your verifier has been serviced, we will return it you with the latest version of the software on CD together with a new calibration sheet, and a new user guide that will include the new certificate of ISO/IEC conformance. The latest software can always be downloaded free of charge from our website, www.axicon.com.

To arrange for your verifier to be serviced:

1. Contact us on
   Telephone: +44 (0) 1869 351155 | Fax +44 (0) 1869 352404
   Email: vcas@axicon.com
2. We will provide you with an RMA number (Return to Manufacturer Authority) and an RMA form.
3. Please fill in all details requested on the RMA form, including the RMA number.
4. Return the verifier (including all cables) in its original case with the completed RMA form, purchase order and your payment details to our VCAS Bureau at Axicon Auto ID Ltd, Church Road, Weston on the Green, Oxfordshire OX25 3QP. We cannot take responsibility for units returned in alternative packaging.
5. We will normally complete the service and re-calibration of your verifier within 7-10 days.
Certificate of ISO/IEC conformance

We, Axicon Auto ID Limited, of Church Road, Weston on the Green, Oxfordshire, OX25 3QP, UK, hereby declare, that the following barcode verifier(s):

Model number(s) ..................................................................................................................................................

Serial number(s) ..................................................................................................................................................

has been designed and manufactured at our address in the UK to verify barcode quality and to conform to: ISO/IEC 15426-1 Barcode verifier conformance specification - Part 1: Linear symbols.

The equipment has been tested and calibrated using primary reference test symbols traceable to the USA’s National Institute of Standards and Technology’s reflectance standards. We also state that this equipment, when used with the latest verifier software, and configured appropriately has the features to meet the requirements of the United States Food and Drug Administration regulation, Title 21 CFR Part 11.

This verifier has been quality assurance checked today, and conforms to this ISO/IEC standard. This declaration of conformity is valid for a year.

Issue date ..................................................................................................................................................

Expiry date ..................................................................................................................................................

Authorised signatory ........................................................................................................................................

Signatory Name .............................................................................................................................................

At or before the expiry date the verifier should be returned to Axicon for its annual servicing and factory re-calibration. This VCAS (verifier calibration and alignment service) will ensure that the verifier remains conformant to ISO/IEC 15426-1 for another year.
Contact us

Axicon Auto ID Ltd
Church Road
Weston on the Green
Oxfordshire
OX25 3QP
UK

Tel: +44 (0) 1869 351 155
Fax: +44 (0) 1869 351 205
Email: info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are subject to change without notice. All trademarks are acknowledged as belonging to their respective companies.

Your Axicon distributor